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Downloading Excel Analysis ToolPak 

The Analysis ToolPak is a Microsoft Office Excel add-in program that is available when 
you install Microsoft Office or Excel. 
To use the Analysis ToolPak in Excel, however, you need to load it first. 

For Excel 2013, 2016 on PC: 

1. Click the File tab, and then click Options. 
2. Click Add-Ins, and then in the Manage box, select Excel Add-ins. 
3. Click Go. 
4. In the Add-Ins available box, select the Analysis ToolPak check box, and then 

click OK. 
• If Analysis ToolPak is not listed in the Add-Ins available box, click Browse to 

locate it. 

• If you get prompted that the Analysis ToolPak is not currently installed on 
your computer, click Yes to install it. 

5. After you load the Analysis ToolPak, the Data Analysis command is available in 
the Analysis group on the Data tab. 

For Excel 2007, 2010 on PC: 

1. Click the Microsoft Office Button  , and then click Excel Options. 
2. Click Add-Ins, and then in the Manage box, select Excel Add-ins. 
3. Click Go. 
4. In the Add-Ins available box, select the Analysis ToolPak check box, and then 

click OK. 
• Tip If Analysis ToolPak is not listed in the Add-Ins available box, 

click Browse to locate it. 

• If you get prompted that the Analysis ToolPak is not currently installed on 
your computer, click Yes to install it. 

5. After you load the Analysis ToolPak, the Data Analysis command is available in 
the Analysis group on the Data tab. 

For Excel 2016 on Mac: 

1. Click the Tools menu, and then click Add-Ins. 
2. In the Add-Ins available box, select the Analysis ToolPak check box, and then 

click OK. 
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• If Analysis ToolPak is not listed in the Add-Ins available box, click Browse to 
locate it. 

• If you get prompted that the Analysis ToolPak is not currently installed on 
your computer, click Yes to install it. 

3. Quit and restart Excel. 

Now the Data Analysis command is available on the Data tab. 

For Excel 2011 or earlier on Mac: 

Analysis Toolpak is not available.  You must install a third-party Data Analysis tool such 
as StatPlus:mac LE free download (Links to an external site.) to perform descriptive 
statistics and Chi Square tests. StatPlus:mac (Links to an external site.) runs alongside 
Excel and offers extra menu options, which run statistical tests on data in an open Excel 
sheet.  If you cannot download StatPlus, cannot access Excel 2016, or cannot access a 
PC with a previous version of Excel, you can still download and follow instructions below 
to create a pivot table (Activity Part 2) on Excel 2011 for Macs without downloading 
additional plugins or software. 

  

http://www.analystsoft.com/en/products/statplusmacle/
http://www.analystsoft.com/en/products/statplusmacle/


Health IT Workforce Curriculum Health Care and Data Analytics 4 
Version 4.0/Spring 2016  Working with Data 

Activity 1: Descriptive Statistics 

Descriptive statistics are an essential step in understanding your data.  
In this exercise, we will look at basic statistics to answer the question, “In 2012, did 
males or females have a higher death rate due to motor vehicle crashes?”  

1. Open the file 
comp24_unit2_dataset_motor_vehicle_occupant_death_rate_by_age_and
_gender.xlsx. This dataset is derived from the Centers for Disease Control and 
Prevention at the address given in your handout (https://data.cdc.gov/Motor-
Vehicle/Motor-Vehicle-Occupant-Death-Rate-by-Age-and-Gende/rqg5-mkef) 
and gives the rate of deaths by age/gender (per 100,000 population) 
for motor vehicle occupants killed in crashes in 2012. 

2. Take a few moments to look at the data. You’ll see the state names along the 
left side, then age ranges in the column headings across the top, as well as 
columns for males and females 

3. Notice that not all states have complete data. For example, Alaska only has 
data listed under “all ages” and nothing for females 

Run Descriptive Statistics for the Males 

1. On the Data tab, click Data Analysis 

 

2. The Data Analysis tools dialog box will display. Click Descriptive Statistics 
and then click OK. 

 

3. The Descriptive Statistics dialog box will display.  
• Input Range: click the drop-down at the right of the Input Range box. This 

will collapse the Descriptive Statistics dialog box so that you can see your 
data. Click the heading for the Males column and drag down until all the 
entries for Males, through the state of Wyoming, are highlighted. Your 

https://data.cdc.gov/Motor-Vehicle/Motor-Vehicle-Occupant-Death-Rate-by-Age-and-Gende/rqg5-mkef)
https://data.cdc.gov/Motor-Vehicle/Motor-Vehicle-Occupant-Death-Rate-by-Age-and-Gende/rqg5-mkef)
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screen should now look like this, and you should now see the entry 
$G$1:$G$51 in the Input Range box.  

 

Click the drop-down arrow at the right again to redisplay the entire 
Descriptive Statistics dialog box.  

Now set these remaining options for the Descriptive Statistics: 

• Grouped By: Click “columns” 
• Labels in first row: This means that row 1 has titles, such as “male” or 

“female”. Click this option. 
• Output range: Where do you want the statistics to be placed? You can 

click the icon at the right of the Output Range field and then click an empty 
cell on your worksheet. In this example, I clicked the first cell in column K.  

• Summary statistics: We want summary statistics, so click this option. 
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4. When your screen is similar to the one below, click OK.  

 

5. Your worksheet will redisplay, and will now have descriptive statistics for the 
males to the right of your original data. Notice that it is placed starting under 
column K. 

 

Interpreting the Data for the Males 
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6. First, look at the entry for Count at the bottom of the report. Go back to the 
original spreadsheet and scroll through the list. Do the counts match? 

7. Now look at the Minimum and Maximum values. These are the lowest and 
highest numbers in the Male column. Again, go back to the original 
spreadsheet and scroll through the list. Are these numbers correct? 

8. Range is the spread or distance between the Minimum and Maximum values. 
This should equal 29.3 – 4.1.  

9. The next item we want to look at is the Mean. This is the average rate for all the 
Males. 

10. The Median is the middle point in the list of numbers, and the Mode is the most 
frequently occurring number. 

11. Now repeat this exercise for the Females, using $N$1 for the Output Range so 
that you can have the results next to your results for the males 

Answer the following questions 

1. What was the average death rate (number of deaths per 100,000) for males in 
2012? 

2. What was the average death rate (number of deaths per 100,000) for females 
in 2012? 

3. How would you compare the rate for males against the rate for females? 

Other things you can do 

Run descriptive statistics on the four Age columns (Age 0-20, Age 21-34, Age 35-54, 
Age 55+). Which has the highest death rate? Does that make sense to you? 
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Activity 2: Using Filters and Creating a Pivot Table Report 

Setup 

Open the file comp24_unit2_dataset_healthcare_associated_infections_state.xlsx. 
[This dataset is from http://www.healthdata.gov/dataset/healthcare-associated-
infections-state] 

Take a moment to scroll through the file. This is a very large dataset, with over 1300 
rows. We want to know about certain types of infections that are occurring in Louisiana, 
Oklahoma, New Mexico, and Texas. For example, some of the questions we are asking 
are: which state has the highest number of surgical site infections from colon surgery? 
Which state has the lowest number of methicillin-resistant Staphylococcus aureus 
bloodstream infections? With such a large file, it is impossible to review the data file and 
answer these questions without some work.  

Creating a Pivot Table 

1. On the Insert tab, in the Tables group, click PivotTable. 

 

2. The Create PivotTable dialogue box will display.  Make sure that Select a table 
or range is selected, and verify the range of cells in the Table/Range box. (If 
you can’t see the entire entry in the field, drag the corner to enlarge the 
window.) The Pivot Table will be placed on a new worksheet in your file.  

http://www.healthdata.gov/dataset/healthcare-associated-infections-state
http://www.healthdata.gov/dataset/healthcare-associated-infections-state
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Click OK. Excel will create and display a new worksheet called Sheet1, and will 
add an empty PivotTable report to this worksheet.  

 

3. Excel will also display the PivotTable Field List so that you can add fields, 
create a layout, and customize the PivotTable report.  
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4. Click State. Excel will place this under ROWS. Notice that the states appear 

along the left side of the screen. However, we want the states to be column 
headings, so drag State to the COLUMNS area. 

5. Click Measure Name. Excel will place this under ROWS. 
6. Click Score. Excel will place this under ROWS. However, this is the actual 

value we are interested in, so drag Score to the VALUES area. Notice that 
Excel changes this to Count of Score, but we want totals for each state. To do 
this, click Count of Score under VALUES area, choose Value Field Settings, 
and change the setting from Count of Score to Sum of Score, and then click 
OK. 
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7. If extra fields appear in the Pivot Table fields, they may affect the final display. 
To remove a field from a section, click the drop-down arrow next to the field’s 
name, and select Remove Field.  
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8. Your final Pivot Table should be similar to this one: 

 

9. Now we have a full Pivot table. To see more of it, close the Pivot Table Field 
List by clicking the X in the top right corner of the panel. 
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10. But notice that we have data for every state and we are only interested in four 
states. We also have lots of entries for confidence limits that we’re not 
interested in.  

 

11. So now we need to filter this report.  
a. In the column heading for Column A, Row Labels, click the drop-down 

arrow at the right.  
b. In the dialog box that appears, uncheck the Select All box, and then 

check only the entries that do not contain “Confidence Limit”.  (If you can’t 
see the entire label, drag the bottom right corner to enlarge the window.) 
You should have 8 types of infections checked.  

c. Click OK. 
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12. Now we want to only display infections reported from Louisiana, Oklahoma, 
New Mexico, and Texas.  

a. In the column heading for Column B, Column Labels, click the drop-down 
arrow at the right.  

b. In the dialog box that appears, uncheck the Select All box, and then 
check only the entries for LA, NM, OK, and TX.  

c. Click OK. 
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13. Your PivotTable should now look like this.  
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Graphing the results 

14. Now let’s create a visualization – a chart – of the results to graphically present 
the data. Starting in the top corner of the data, click and drag until the entire 
table is selected. 

 

(Here’s a tip: You can click the first cell, then hold down the Shift key and then 
click the bottom right cell. Sometimes that is easier than clicking and dragging.) 

15. Click Insert  PivotChart  PivotChart (Note: this may look different on 
different versions of Excel) 

 

16. Choose Clustered Column and click OK. You should now see a column chart 
similar to this one: 
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To see the complete label for each set of columns, grab each side of the chart 
and drag to enlarge the chart. You can also drag the chart vertically to adjust the 
height of the columns. The chart should now look like this: 
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Discussion Questions: 

1. Which state has the highest number of surgical site infections from colon 
surgery?  

2. Which state has the highest number of methicillin-resistant Staphylococcus 
aureus bloodstream infections?  

3. Which state has the highest number of surgical site infections from abdominal 
hysterectomy? 

4. For all the infections reported in the PivotTable, which state has the lowest 
number of infections? 

5. For all the infections reported in the PivotTable, which state has the highest 
number of infections? 

Other things you can do: 

• You can use the PivotTable Field List to rearrange the fields later as needed by 
right-clicking the fields in the layout section, and then selecting the area that you 
want, or by dragging the fields between the areas in the layout section. 

• Click the Options and Design tabs of the PivotTable Tools that become available 
when you click anywhere in a PivotTable, and then explore the groups and 
options that are provided on each tab. 

• You can also access options and features that are available for specific 
PivotTable elements by right-clicking those elements. 

• For detailed information about how to work with PivotTable reports and 
PivotChart reports, see Overview of PivotTable and PivotChart reports, Create or 
delete a PivotTable or PivotChart report, and Pivot data in a PivotTable or 
PivotChart report on Office.com. 
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Activity 3: Column Charts and Histograms 

In this tutorial you will learn the difference between a column chart and a histogram and 
learn how to create them. 
Column charts and histograms initially look very similar. However, they are quite 
different. 

• A column chart plots each value in a data set as a vertical column 

• A histogram is a graph that shows the frequency of values in a data set – in other 
words, how many times a particular value occurs -- and so histograms are very 
useful for showing how the data are distributed.   

1. Open the file  
comp24_unit2_dataset_prevalence_and_trends_data_tobacco_use.xlsx 
[This dataset is derived from https://data.cdc.gov/Smoking-Tobacco-
Use/BRFSS-Prevalence-and-Trends-Data-Tobacco-Use-Four-/8zak-ewtm] 

2. Take a few moments to look at the data. You’ll see the year and state names 
along the left side, then four categories of smoking status in the column 
headings across the top. Notice that the year goes from 2010 down to 1995, 
and that there are over 800 rows in the file. 

 

Run Descriptive Statistics  

3. Refer to the instructions for the tutorial on descriptive statistics. Run 
Descriptive Statistics on the 2010 data. For this video, I have already created 
the descriptive statistics. You will need to format the output for each Mean 

https://data.cdc.gov/Smoking-Tobacco-Use/BRFSS-Prevalence-and-Trends-Data-Tobacco-Use-Four-/8zak-ewtm
https://data.cdc.gov/Smoking-Tobacco-Use/BRFSS-Prevalence-and-Trends-Data-Tobacco-Use-Four-/8zak-ewtm
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value so that they display as percentages. To do this, right click each Mean, 
then choose Format Cells, then Percentages, and then click OK. 

 

4. Your descriptive statistics for 2010 should look like this: 

 

5. Now run Descriptive Statistics on the 1995 data, formatting the Means as 
above. 

6. Compare the two sets of data. Can you draw any conclusions yet? 
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Creating a Column Chart 

In this step, you will graph the “smoke every day” data for all states for 2010. This is so 
that you will be able to see the difference between a column chart and a histogram. 

1. Click in the cell labeled Year (cell A1) and drag down and to the right until 
Wyoming’s 2010 value of 14.90% is highlighted. Your screen should look like this: 
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2. On the Insert menu, click the column chart icon and then choose Clustered 
Column (Note: this may look different on different versions of Excel) 

 

3. Excel should now create a column chart similar to this one. Note that to 
improve the readability of the chart, you may need to grab the right or left side 
and drag to enlarge the chart. 

 

 
4. If the Y axis values are not displaying as percentages, right-click one of the 

numbers on the Y axis and choose Format Axis. Under Number, change the 
category to Percentage. The Y axis will now show the percentages. 
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5. Study the column chart. What can you tell from this chart? How difficult do you 
think it would be to interpret this chart if it included all four smoking statuses for 
all the years in the spreadsheet? 
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Creating a Frequency Table and Histogram  

A frequency table shows how many times a value occurs in a data set, and a histogram 
is a graph of that data. Take a look again at the data for the “Smoke everyday” category. 
What we want to do is to set up groupings or “bins” for the values to fall into, such as 0-
5, 6-10, 11-15, and so on. So how do we decide what those categories should be? 

1. First, let’s look again at the descriptive statistics for the “Smoke everyday” 
category. The Minimum value is .036 or 3.6%, and the Maximum is 0.232 or 
23.2%.  

  

2. So, we could create our categories, or “bins”, as 0-5, 6-10, 11-15, 16-20, and 
21-25. To do this, click in the first row under column H and enter the following 
values: 0, 5, 10, 15, 20, 25. Your entries should look like this: 

 

3. Now you are ready to create the frequency table and the histogram. Choose 
Data  Data Analysis and then choose Histogram. Click OK. 
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4. The Histogram dialog box will display. 
• For Input Range: enter the range of cells for 2010 Smoke Every Day (should 

be $C$2:$C$55) 

• For Bin Range: enter the cells where you put your categories (should be 
$H$1:$H$6) (Remember that you can click the drop-down at the right side of 
the field, then highlight the desired cells, and then click the drop-down again 
to redisplay the entire dialog box.) 

• For Labels: we don’t need to check this option because we didn’t add a 
column label for the Bin column, and we didn’t use cell C1, which was the 
label for the Smoke Every Day column.  

• For Output Options: click New Worksheet Ply to have the results show up 
on a new worksheet. (You may or may not see a value in Output range 
depending on the version of Microsoft Excel). 

• Check Chart Output to have Excel automatically graph the results as a 
histogram. Your screen should look like this: 

 
• Click OK.  

5. Excel will create a new worksheet called Sheet1 and will display this worksheet. 
You should see the following output (recall that you can reformat the axes to 
display as percentages) 
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To see more levels in the Frequency axis, such as 25 and 35, drag the 
histogram down to expand it. 

 

6. Now create a frequency table and histogram for the following sets of data (Tip: 
you will need to run Descriptive Statistics and adjust your bins): 
• Smokes Every Day data for 1995 

• Never Smoked data for 2010 

• Never Smoked data for 1995 

7. Compare the four histograms. Comparing 1995 data to 2010 data, what 
conclusions can you draw about smoking in the United States? 
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Activity 4: Testing for Independence with Chi Square 

1. A Chi square test for independence tests to see if there is a relationship 
between two categorical (nominal) variables. Another way to state this is 
whether the two variables are independent of each other.  In this exercise, we 
will answer the question, “From 1997-2014, is there a relationship between 
income and heart disease for people 55-64 years old?”  

2. Open the file comp24_unit2_dataset_chonic_conditions.xlsx 
This dataset gives data on persons reporting specific chronic diseases on the 
National Health Interview Survey. [This dataset is derived from Health 
Conditions  Chronic conditions at 
http://205.207.175.93/hdi/ReportFolders/reportFolders.aspx]. 

3. Take a few moments to look at the data. You’ll see the parameters that were 
used to generate the report on line 4, and then on line 6, the different chronic 
diseases, such as heart disease, stroke, and arthritis. Along the left side are 
age categories, subdivided into income levels of Poor, Near poor, and non-poor. 
There are also numerous comments, indicated by the red triangles, that display 
messages when the cursor is hovered over them. 

 

http://205.207.175.93/hdi/ReportFolders/reportFolders.aspx
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Set up a table of observed values 

Since we want to look at the relationship between income level and heart disease for 
people between 55-64 years old, we need to set up a table that has columns for Income 
Level, Has Heart Disease, and No Heart Disease. This will be our Observed Values. 

1. Copy the values for Income and Heart Disease for rows 37, 38, and 39 to a 
blank area of your worksheet. This gives us the number per 100 patients who 
reported that yes, they had heart disease: 

 

2. Now we need to manually calculate how many patients per 100 who did not 
have heart disease. In the blank column to the right, subtract each value from 
100.  

3. Add a title above each column; the first column should be Income, the second 
“Heart Disease per 100”, and the third column “No Heart Disease”.  

4. Above the Income column, add the title “Observed Values”. 
5. Your work area should now look like this: 

 

Set up a table of expected values 

The Chi square test needs to have a range of expected values to compare the observed 
values against. For the purposes of this exercise, we will use the data for All patients 
between 55-64 years old on row 36, which has a value of 15.8. 
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6. Copy the cell with the value All and the adjacent cell with the value 15.8. This 
gives us the number per 100 patients, of all income levels, who reported that 
yes, they had heart disease. 

7. Paste this section a few lines below your new Observed Values area of your 
worksheet. 

8. Now we need to manually calculate how many patients per 100 who did not 
have heart disease. In the blank column to the right, subtract 15.8 from 100. 

9. Since we have three rows of data in our Observed Values area, we have to 
have three rows in our Expected Values area. Copy the three cells “All”, “15.8”, 
and “84.2” to two additional rows.  

10. Add the title “Expected Values”.  
11. Your work area should now look similar to this: 

 

Run the Chi square test for independence 

12. Click in an empty cell underneath your table of expected values.  
13. On the menu bar, choose Formulas  Insert Function. The Insert Function 

dialog box will display. Type in CHI in the search box and click Go. 
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14. A list of functions whose names begin with CHI will be displayed. Select 

CHISQ.TEST and click OK. 

 
 
 

15. You will now see the Function Arguments dialog box for the CHISQ.TEST 
function. 

 

• Actual_range: click in the Actual Range field, then click the cell with the 23.8 
value and drag down and to the right until all six data values for the Observed 
Values are highlighted. The cell names will be entered in the field. (Note that your 
cell names may be different, depending on where you placed your data in your 
spreadsheet.) 
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• Expected_range: click the Expected Range field, then click the cell with the first 
15.8 and drag down and to the right until all six data values for the Expected 
Values are highlighted. The cell names will be entered in the field. Again, your 
cell names may be different. 

• Click OK. The number 0.023147 should appear in the cell. 
Interpreting the Data 

In this case, the result reported as 0.023147.  

• If the value is less than or equal to (< =) 0.05, then there is a statistically 
significant relationship between income level and heart disease. 

• If the value is greater than ( > ) 0.05, then there is not a statistically significant 
relationship between income level and heart disease 

Answer the following questions 

• Is there a statistically significant relationship between income level and heart 
disease?  

• Are heart disease and income level independent of each other? 
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